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CHAPTER 3
ICONS, WINDOWS,
FILES, AND FOLDERS

Icons

The Floppy Disk Icons

When you first switch on your ST Computer, the GEM Desktop
displays two Floppy Disk icons in the upper left-hand corner.

FLOFPY DISK
FLOFFY DIZE

The icons themselves don’t look like disk drives; instead, they
resemble file drawers. Your disks and drive constitute the computer’s
filing system—the way you store and retrieve information when
working with the ST Computer. The Floppy Disk icons allow you to
view, control, and manipulate the files stored on the disks.

The Trash Icon
The Trash icon works like a real trash can. When you want to
delete a file from a disk, drag the item to the Trash icon. The
Delete box then appears, and you can instruct the computer
to erase the file.

o

lif

TRASH
Warning: The Trash icon works more like an incinerator than a

trash can. Once you throw something away, it's gone forever.
You can'’t reach back in and pull it out again.
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Windows

On most computers, all the activity takes place on the full video
display screen. On the ST Computer, much of the activity takes
place in areas called “windows.” Windows are miniature screens
within the larger video screen that display the files on your disks,
among other things. The GEM Desktop allows you to have up to
four windows open at a time.

Note: The open windows in this manual are examples only. The
copy you made of your ST Language disk may show a different
number of bytes used and different files.

Opening Windows

There are two methods of opening a window. The first method is
selecting a Floppy Disk icon, then pointing at and clicking on the
Open option under the File Menu.

The second method is called “double-clicking.” It is both faster
and more convenient than using the Open option. You simply point
at a Floppy Disk icon and quickly click the left mouse button twice.
With the GEM Desktop displayed and your Working ST Language
disk in Drive A, try double-clicking on Floppy Disk A to open its
window.

Once Floppy Disk A opens, you'll see its file icons and their
names, along with the window utilities at the window's top,
right, and bottom borders.
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Close Box Mc7 Bar Disk Identifier Fuli Box

Information Line —— 155147 bgtes used in 5 ltens

szc RSC

Bﬁsl“ PRG CONTRDL ACC ENULRTOR ACT :ﬁmPLE PRG

Scroll Arrows

B
el —IolE
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Scroll Arrows Size Box

The Disk Identifier tells you which disk you’'ve opened (either A or
B). The Information Line tells you the sum of the bytes used and
in how many items. (To view the remaining storage capacity of a
disk, refer to Show Info in Chapter 4.)

A window is active when the Move Bar (along the top edge) is
shaded and the Scroll Bars (along the right and bottom edges)
contain the Scroll Arrows and utility boxes. An active window can
be sized, moved, dragged, or have its contents scrolled. Only one
window can be active at a time. If you have more than one window
open, you can make any open window active by pointing at and
clicking on it.
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Moving Windows

You can move a window to any position on the GEM Desktop by
using the Move Bar located on the top edge of a window. To move
a window, point at the Move Bar, press and hold the left mouse
button, then drag the window to any location on the GEM Desktop
and release the button. The window pops into its new position.

Moving a Window
Desk Fil

Move Bar

View Dptions_

155147 bytes used in 5 items.

RG eAsIC .RSK CONTROL.ACC EMULATOR.ACC  SAMPLE.PRG

Moving windows is especially useful when you need to position
more than one open window on the GEM Desktop (for example,
as you copy files from one window to another).
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Sizing Windows

You can make a window any size you want. First point at the small
box called the Size Box in the lower right-hand corner of the window,
then press and hold the left mouse button. Now drag the Size Box in
the desired direction—move down to lengthen the window; up to
shorten it; right to widen it; and left to narrow it.

Sizing a Window

Full Box Size Box

Vi
155147 bytes used_

P

BASIC.PRG ERSIC.RSC CONTROL.ACC

Sizing windows is also useful when you need to position more than
one open window on the GEM Desktop (for example, as you copy
files from one window to another).

A quick way to enlarge a window is to point to and click on the small
box called the Full Box in the upper right-hand corner of the window.
When you click on this box, the window expands to fill the entire
screen. Clicking on the Full Box again returns the window to its
previous size, shape, and position on the GEM Desktop.
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Full Screen Window

Full Box
Desk File View Options

— @
AEF e N
ASIC RS

BASIC.PRG C CONTROL .ACC EMULATOR.ACC SAMFLE.PRG
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Scrolling Windows

If you want to see items that may be cut off at the edges of a
window, but there isn’t enough room to enlarge that window,
you can “scroll” the contents of the window. The two Scroll
Bars—one along the right and the other along the bottom edge
of the window — will scroll the contents to the right or left, or
up and down.

A portion of the Scroll Bar will be shaded when files are hidden that
you might not otherwise notice or remember. If shaded, the arrows
indicate in which direction the unseen items sit. The unshaded
portion of the Scroll Bar is proportionate to the fraction of the total
that you currently see; likewise, the shaded portion is proportionate
to the fraction of the total that is hidden. If no part of the Scroll Bar is
shaded, then no items are hidden from view.

To scroll, point at the arrow indicating the direction of the hidden
contents, then click the left mouse button. Clicking on the arrows
moves the display by one “unit” (icon).
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Close Box —=

155147 bytes used in 5 items.

00 D

Scroll Box BASIC.PRG BASIC.RSC CONTROL .ACC

Scroll Arrows

Scroll Bar ——¢] ¥

Scroll Arrows

There are two other ways to scroll the contents of a window. One
is to drag the Scroll Bar's unshaded portion up or down (vertical
Scroll Bar) or left or right (horizontal Scroll Bar). A second method
is to click on the shaded areas of the Scroll Bars. Clicking on the
shaded areas moves the display one “view-unit” (the currently
visible area’s size).

Updating Windows

Under certain circumstances, a directory window's display may
not match the actual files on the disk in that drive. For instance, if
you have Floppy Disk As window open (presumably displaying the
files on a certain disk), then you insert a different disk in the drive
(presumably containing different files), the directory display will
not automatically be updated simply by inserting the new disk.
To update an open and active window’s directory, press [Esc].

Closing Windows

To close a window, click on the small box called the Close Box
in the upper left-hand corner of the window. The window will
immediately close and return you to another window, if one is
on screen, or to the GEM Desktop. (For more information, see
Close and Close Window in Chapter 4.)
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Managing Files and Folders
Types of Files

Your ST Computer stores two types of files on disk: data files and
program files.

Program
Files

155147 bytes used in 5 itenms.

rlll N

EASIC.RSC OMTROL.ACT  EMULATOR .ACC HMFLE PRG

B
3l Y1/ B
N\ T
Data Files

The icons that look like sheets of paper with a corner folded over
represent data files. These files contain data that are used by
applications programs.

The icon without the folded corner is a program file. Program files
contain programs.

A third icon, not shown here, looks like a file folder. Folders may
contain several files, and provide a way to group related files on
your disks. (For more information, see Folders later in this chapter.)

Opening (Running) Files

There are two methods of opening a file from the GEM Desktop.
The first method is to select the file’s icon, then point to and click
on the Open option under the File Menu. The second method is to
double-click on the file's icon.
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Try doubie-clicking on the program file “SAMPLE.PRG.” The icon
will open into a window, and the program will start. This demon-
stration program lets you practice your window sizing, moving, and
closing skills. To exit from the program, close the program’s
window. (For more information on opening program files, see
Chapter 5.)

You can only print or display a data file; a Dialog Box informs you
if one is ever opened.

Copying Files

With many computers, copying files is a complicated process involv-
ing numerous commands. On the ST Computer, to copy any type of
file, you select that file's icon and drag it to where you want to put the
copy. If you want to copy a file onto another disk, simply drag the file
icon to the icon for that disk, making sure the file’s icon is on top of the
disk’s and that the disk’s icon reverses shading.

How to Copy the CONTROL.ACC and EMULATOR.ACC Files

Your Working ST Language disk contains files not essential to the
running of the GEM Desktop. The bulk of information on the disk is files
that run the programming language, ST BASIC, that you received
with your ST Computer (see Chapter 5). But the disk also contains two
desktop files that you will find handy to have on a separate disk. They
are the CONTROL.ACC and EMULATOR.ACC files.

To copy the two files, follow these steps:

1. Format a new, blank disk. In the Format box, name the disk
“Desktop.” You can format it for single- or double-sided record-
ing. (To review the format process, see How to Format Your
Blank Disk in Chapter 2))

2. Remove the formatted disk and insert your Working ST Language
disk into the drive. (If you have two disk drives, you can leave
both disks installed.) Now double-click on Floppy Disk A to
open its window.

3. Drag the CONTROL.ACC icon onto the Floppy Disk B icon; the
Floppy Disk B icon must reverse shading. Now release the left
mouse button. (Or, try selecting and dragging both files to Floppy
Disk B at once; see Multiple Selections later in this chapter.)
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Desk File View 0Options

J

BASIC.PRG EASTC.RSC GG EMULATOR .ACC

4. The GEM Desktop now displays the Copy box.

COPY FOLDERS / ITEMS

Folders to Copy: -___8
Items to Copy: -1

| 0K || Cancel |

Click on the OK button. The Dialog Boxes that follow instruct
you when to switch disks, if necessary.

5. Repeat steps 3 and 4 to copy the EMULATOR.ACC file.

Whenever you switch on your system, you can now use this new
disk in your drive. You no longer need your Working ST Language
disk when switching on the system (unless, of course, you want
to run the programming language). The new disk has all the infor-
mation your ST Computer needs to provide the full set of ST
Computer Desk Accessories. Label the new disk ““Desktop.” (For
more information, see Switching Your System On Without the
Desktop Disk and Save Desktop in Chapter 4.)

Note: When you copy to a Floppy Disk icon, if the disk’s window is
open at the time of copying, it will not be updated when copying is
complete. To update the disk window, activate it and press [Esc].
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Alternative Methods of Copying Files

There are other methods of copying files from one disk to another. One
way is to drag a file from one open window to another; for instance,
dragging a file from Floppy Disk A’s open window to Floppy Disk B’s
open window. This will copy the file from Floppy Disk A to Floppy Disk B.

Dragging a File from One Window to Another

Desk File View 0Options
2 2 i\
FLOPPY DISK 155147 bytes used in 5 itenms.

;

FLOPPY DISK BASIC.PRG BASIC.RSC

"
[

o

LR EMULATOR .ACC

B:\
B bytes used in B items.

f

TRASH

Another method is to drag a Floppy Disk icon to an open disk window;
for instance, dragging Floppy Disk A’s icon to Floppy Disk B’s open
window. This will copy the contents of Floppy Disk A to Floppy Disk B,
but will leave Floppy Disk B’s contents intact.

Both of these methods allow copying, provided there is room, from
a double-sided disk to a single-sided disk and vice versa.
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Dragging a Disk lcon to a Window
Desk File View Options

A
(]

FLOPPY DISK

L] vi
sxc RSC

BASIC.PRG CDNTRDL ACC ENULRYOR ACC

1

TRASH

A third method of copying files is to drag a file into a folder. (For a
description of that process, see Folders later in this chapter.)

Note: It's a good idea to make a backup copy of every file. If
anything should happen to the original, you'll then always have
a reserve copy on hand.

Multiple Selections

Sometimes you will want to select more than one icon. As you
have seen, however, once you click on an icon, clicking anywhere
else on the screen cancels your first selection.

There are two methods of selecting more than one icon. The first
is to press and hold the left mouse button while the mouse pointer
is to the left of the icons you want to select (nearby but not touch-
ing). Then drag the pointer down, to the right, and across the desired
icons. As you drag the pointer, a rubber-band-like box will form around
the icons, and every icon inside that box will be selected after you
release the left mouse button. Once the items are selected, hold down
the left mouse button while the pointer is on one item in the selected
group. Now drag the entire group to where you want it.
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Dragging the Pointer

bytes used in 5 items.

0 4T

i BASIC.PRG BRSIC.RSC | CONTROL.ACC EMULATOR .ACT

<l I o

Selecting Items

Dragging the Items

155147 bytes used in 5 items.

I By

CONTROL.ACE  EMULATOR .ACC

<]

The second method for selecting more than one icon is to hold
down the [Shift] key on the keyboard while you click on the icons.
This is a convenient method when the items are not in sequence
and cannot be separated from one another within the pointer’s
rubber-band box. Once the items are selected, hold down the left
mouse button while the pointer is on one item in the selected group.
As before, now drag the entire group to where you want it.

Note: Holding down [Shift] and clicking on icons actually switches
between selected and unselected. That is, if selected, [Shift]-click
will deselect the item; if unselected, then it will select the item.
Sometimes you may find it convenient to combine the two methods
of multiple selection: use the pointer’s rubber-band box to select,
then deselect the undesired items by [Shift]-clicking on them.
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Deleting Files

To delete a file, select and drag the file to the Trash icon and follow
the instructions on your screen. And remember: once you put
something into the Trash, it’s gone forever.

Renaming Files

To rename an existing file, select the file, point at the File heading
on the Menu Bar, and select the Show Info option.

ITEM INFORMATION

Name: SAMPLE .PRE|
Size in bytes: ____4548
Last modified: 05/29/85 05:41 pm

Attributes: Read/Nrite
Read-0nl

This sample Dialog Box shows the name and attributes of a file.
You see a cursor (the vertical line) at the end of the filename. To
change the filename, press [Backspace] or [Esc] on the ST Com-
puter keyboard until you delete the old name and the cursor is at
the beginning of the name block. Then type in the new name.

Note: Filenames can have a maximum of eight characters, optionally
followed by a period (.) and a three-character extension.

Warning: Do not change the three-character extension for any of the
files you received on your ST Language disk. If you do change an
extension, you may prevent the system from using that file appro-
priately. (For more information on filenames and extensions, see
Show Info and Install Application in Chapter 4.)

) F - 4



S S S

Folders

Folders are organized collections of files. They are neither programs
nor data; you create folders as a means of organizing your files. If you
have a window that contains numerous files, it can become difficult to
distinguish any one item from the others. Because you may want to
organize those files to make them readily accessible, the GEM

Desktop allows you to create folders in which to store related files.

To create a folder, open a Floppy Disk icon, then point at the File
heading on the Menu Bar and select the New Folder option. The
following Dialog Box comes up on your screen:

NEW FOLDER
Name: SAMPLE._.._.
L0k ] [Cancel ]

Type in a name for the folder and click on the OK button. If you
change your mind about adding a folder, click on the Cancel
button instead. Once you give the new folder a name and click
on the OK button, the new folder pops into the currently active
window.

i]llllli

SAMFLE BASIC.PRG CONTROL.ACC EMULATOR.ACC  SAMPLE .PR

=]

& [

Note: Folders cannot be renamed.

) r - 4




S S S

To put a file into the folder, simply drag it to the folder. When the
folder icon highlights, release the left mouse button, then foliow the
prompts in the Dialog Box and the file will be copied into the folder.

Dragging Files into a Folder

155147 bytes u;ed in 6 items.

.. :

. ~BAFIC.PRE -y BASIC.RSC MR SAMPLE.PRG

=[]

<] [

COPY FOLDERS / ITEMS

Folders to Copy: ___8
Itens to Copy: _-__2

[ ok | [Cancel |

Once you create a folder, you can continue to copy files into it.
You can even copy the entire contents of a disk to a folder. Simply
drag the Floppy Disk icon to the folder and follow the prompts.
This method of duplicating a disk works, provided there’'s room,
when one disk is double-sided and the other disk is single-sided,
and vice versa.

Note: Copying a file into a folder creates a new copy of the file
and places it in the folder. After you place a copy of the file into
a folder, you can delete the old file by dragging its icon onto the
Trash icon.
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Opening Folders

Every folder may be opened to its own window. If you open a Floppy
Disk icon that contains a folder, the window won’t immediately reveal
the contents of the folder. You must open the folder into its window to
view the items it contains.

To open a folder, either double-click on the folder’'s icon or select
the folder (by single-clicking), then choose the Open option under
the File heading.

Opening a Folder
_ Desk JICY View Options

15514? bytes used in 6 ltens.

LPPV DI gf:sznlder - i . . . .

Close Window EEEECGE  srcic.PRG SIC.RSC CONTROL.ACC  EMULATOR .AC

| Farpat. .

The folder actually opens in the former place of its parent disk’s
window. Once the folder is opened, its contents can be accessed.
Sample Open Folder

. AI\SAMPLEN
2 items.

N

CONTROL.ACT  EMULATOR .ACT

<] [>]r
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If you wish to open two folders at once (to copy data from one
folder to another), open the Disk icon again, then select and open
the next folder. Now the screen displays both folders’ windows,
and you can copy items from one folder to another.

Note: You can also create a folder within a folder, and can continue
to do so down to eight levels.

Paths and Pathnames

Folders are actually directories within the main, or “root,” directory
of a disk in a disk drive (e.g., Drive A). A folder within a folder is a
directory within a directory of the main disk directory. In order to keep
all these directories straight, each has its own name. Pathnames
designate main directories and folders.

Pathnames are of the form:
drive specification:\folder name\

where the drive specification specifies a root directory and the
folder name specifies a folder. Each component of the pathname
must be separated by a “backwards” slash (\). For example, the
specification of the folder \LETTERS on floppy Drive A would
appear as follows: A:\LETTERS\.

Folder in Main Directory

T e

LETTERS CONTROL.ACS  EMULATOR.ACC WORDPROC.FRG

[ [S1K
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Open Folder

ytes used in 2 items.

*

MOTHER MIKE.LET

B
]

¢ B

And the specification of the path created by placing the folder
\MOTHER within \LETTERS on Drive A would appear as
ANLETTERS\MOTHERA\.

Open Folder within a Folder

- A:\LETTERS\MOTHER\
used in 2 items.

g

MOM1,LET MOMZ . LET

B
r

o] [o

Prefixing a pathname to a filename tells the computer that you
want to store or retrieve, for example, that file from the directory
designated by the pathname. For example, suppose you have
stored the letter MIKE.LET in the folder \LETTERS on Drive A.
Suppose further that you've run your word processor from the
main directory A:\. When running the word processor, you will not
be able to access the file MIKE.LET unless you prefix the correct
pathname to the filename, that is, A\LETTERS\MIKE.LET.

Deleting Folders

When you want to delete a folder, drag it onto the Trash icon and
follow the instructions on your screen. Keep in mind, however, that
all files in the folder are deleted when the folder is deleted.

51
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CHAPTER 4
THE MENU BAR

Along the top of the GEM Desktop is the Menu Bar. The menu
headings are: Desk, File, View, and Options. To see the options
within any menu, point at the menu heading. The heading high-
lights and the menu automatically drops down.

When you are ready to select a menu option, point at the option
you wish to use and click the left mouse button once. The light-
ened words are options not available to you at the particular time
you pull down the menu; they require that you first select or open
a relevant file or disk.

Desk

The Desk heading contains the computer’s Desk Accessories
Menu. You may access the Desk Accessories in the menu at
almost any time, provided you are using the GEM Desktop or
another application that uses the GEM Menu Bar format. The
standard set of Desk Accessories includes the VT™52 Emulator,
Control Panel, Set RS232 Configuration, and Install Printer. How-
ever, particular GEM-compatible applications may contain Desk
Accessories that differ slightly from the standard set.

PI3TR File View Options
| Desktop Info... »

UT52 Emulator
Control Panel
i Set RS232 Config.
_Install Printer

Note: Any changes you make to the standard Desk Accessories
may be saved to disk. See the Save Desktop option later in this
chapter.
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Switching Your System On Without the Desktop Disk

If you switch on your computer without first inserting a disk with
the CONTROL.ACC and EMULATOR.ACC files on it, the Desk
Menu will contain only one item — Desktop Info.

(I3 File View Options
Desktop Info,...

FLOPPY DISK

Doing without the Desk Accessories does free up some of the
computer’s memory, but usually you'll want the Desk Accessories
present. (For more information, see the section on Slow Boot/
Fast Boot in Appendix A.)

Desktop Info

The Desktop Info option is the billboard for the GEM Desktop, display-
ing the title of the desktop program in use and the program’s copyright
information. Most GEM Desktop-style programs will display this kind
of identifying information when you select this option.

Point to and click on Desktop Info. You see the following Dialog Box:

GEM, Graphics Environment Manager

Copyright (c) 1985
ATARI CORP.
Digital Research, Inc.
All Rights Reserved.

Click on the OK button to return to the GEM Desktop.
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VT52 Emulator

The VT52 Emulator is an industry-standard telecommunications
terminal program. When a modem is connected to your ST Computer,
this program lets your computer communicate with other computers.
Since the program is a bare terminal emulator only, it is most useful
when used to hook into a large mainframe system.

Point to and click on the VT52 Emulator option from the Desk
Menu. The VT52 Emulator immediately comes up on your screen.

g e e T T I TR
¥ Atari UTS2 Terminal Emulator %
* (0 Atari Corp. *

FHHEHEEHEEHHREEEHEEEHEEHEHOHHEHH
Press: 1) UNDO to return to desktop.
2) HELP to configure terminal.

To configure the Modem port, press [Help] (see the instructions
on the Set RS232 Configuration option later in this chapter). To
return to the GEM Desktop, press [Undo].

Control Panel

This option allows you to alter a variety of system features. The
Control Panel is a systemwide installation—the panel’s settings
affect the system as a whole. The Control Panel is divided into
five sections: Clock/Calendar, Keyboard Response, Mouse Click
Response, Audio Feedback, and Palette Control.

Point to and click on the Control Panel option in the Desk Menu.
The Control Panel appears.

ol

CONTROL PANEL :
12:08 AM | 11/28/85 J ——— Clock/Calendar

- P <———— Keyboard Response Selector
o (e](1][z]HI[4] @ ~—— Mouse Click Response
g Tl | Cancel

= Audio Feedback
]
||

Palette Control ——

Palette Boxes ——— || I H W HE N
EENEDE H AN
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Once you've set the Control Panel parameters, click on the Close
Box in the upper left-hand corner. To reset the panel to its previous
setting, click on the Cancel button (or press [Return]).

Clock/Calendar

To set the clock or calendar, position the mouse pointer in the Clock
window (left window) or the Calendar window (right window) and
click the left mouse button. The window reverses shading to mark
your selection. Use [Backspace] to position the cursor towards the
beginning of the block (or [Esc] to erase the block), and enter the
correct time or date directly from the ST Computer keyboard.
When you finish, click in the Clock or Calendar window again (or
press [Return]).

Once you set the time and date, the computer tracks the passage of
time as long as it remains switched on. The system uses the Clock/
Calendar to note the date and time individual files are created or
revised (see the sections on Show Info and Show as Text later in
this chapter). If you desire an accurate record of when your files
are created or revised, you should reset the Clock/Calendar each
time you switch on your computer.

Keyboard Response

Every key (except [Shift], [Control], and [Alternate]) on the ST Com-
puter keyboard will repeat if you continue to hold it down. The
Keyboard Response selector controls how soon the keys start
repeating and how quickly they repeat.

The Upper Slide (Finger/Key icons) controls how soon the keys begin
repeating once the key is held down: moving the slider to the left
makes the keys repeat sooner. The Lower Slide (Rabbit and Turtle
icons) controls the speed at which the keys repeat once they begin:
moving the slider to the left makes the keys repeat faster. These two
slides are particularly useful for adjusting the responsiveness of the
cursor keys.

To set either slide, select then drag the slider to the desired position
and release the left mouse button.

Mouse Click Response

If you do not double-click quickly enough, your computer may
interpret the clicks as two separate single clicks. To slacken the
computer’s double-click response (allowing you to double-click
more slowly), select one of the numbered boxes nearer to the
Resting Mouse icon.
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For experienced users, a slower double-click response may be
inconvenient. To quicken the computer’s double-click response
(requiring you to double-click faster), select one of the numbered
boxes nearer to the Running Mouse icon.

Audio Feedback

The ST Computer has two kinds of audio feedback: a click after
each keystroke and a bell after keyboard and mouse movement
errors. (A common mouse movement error occurs when you try to
select another function before exiting a Dialog Box.) These sounds
are emitted from your monitor's speaker. To activate or deactivate
the computer’s audio feedback, click on the Keytop icon or the
Bell icon. An unshaded icon indicates that the function is active;

a shaded icon indicates that it is disabled.

Palette Control

The Palette Control is fully functional only when you use either an
ATARI Color Monitor or a color television (if applicable) as the
computer’s video display. However, with an ATARI High-Resolution
Monochrome Monitor, the Palette Control does allow you to select
either black text and graphics on a white background (defauit) or
white text and graphics on a black background.

] CONTROL PANEL
LA 12:00 AN | 11/26/85

Primary Color Slides —

b

Palette Control ~——— a BiL) lE @
@ E Cancel

DIIIIIII
Innnnnnn

Palette Boxes ——
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The Palette Boxes along the bottom of the Control Pane! display
“swatches” of color that you can modify. The Primary Color Slides
allow you to mix the three primary video colors (Red, Green, and
Blue) to make a palette of the colors you want. In low-resolution
color display mode, the ST Computer can display up to 16 colors
at one time from a palette of 512 colors (all 16 Palette Boxes are
active). In medium-resolution color display mode, your ST Com-
puter can display up to 4 colors at a time from a palette of 16
colors (the first two Palette Boxes in each row are active).

Click on one of the Palette Boxes along the bottom of the Control
Panel. To modify the selected color, move any one of the three
Primary Color Slides to the position you desire. You can move a slide
by dragging it or by clicking on the “R,” “G," or “B" along the top
or bottom of each slide. Each slide has eight positions (0 through 7).
Selecting a higher-numbered position increases the primary color’s
saturation-level relative to the selected palette color.

To invert the current monochrome display, set all sliders to position
Oor7

Set R$232 Configuration

The port labeled “Modem” on the back of the ST Computer is an
RS232 serial port. By connecting a modem to your computer, you
can communicate with other computers. You may also connect a
serial printer, or any other RS232 device, to the Modem port.

When you select the Set RS232 Configuration option, the desktop
displays the following Dialog Box:

RSZ3Z PORT CONFIGURATION

Baud Rate!
Parity: [TTTA[ 0dd ](Even]
Duplex:

Bitsschar: I 7 1T 6 [ 5 |

strip Bit: [T 0FF ]

Flow Control
Xon/Xoff!
Rts/Cts:
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The RS232 Configuration box lets you match the computer’'s R$232
port with the configuration of the modem (or serial printer) you are
using. Refer to your modem manual for specific information on
which parameters to choose. The major choices presented to you
are explained below.

Baud Rate

Baud rate is the speed at which data is transmitted. (Baud, the
standard unit measure of transmission speed, is measured in bits
per second.) The fastest rate available to you is 9600 baud; the
slowest is 300 baud. You must set the baud rate to accommodate
both your modem and the remote computer’s modem.

Parity

Whenever computers send information over the telephone lines,
there is a chance that some of the information may get garbled,
oftentimes due to imperfections and “noise” within telephone
lines. Parity is a method that computers use to examine informa-
tion and determine whether it has been cleanly transmitted. The
parity bit is a binary digit added to a group of bits to make the
total of all bits odd or even. Depending on your modem and the
remote device, you will choose either ODD, EVEN, or NONE.

Duplex

Half Duplex configures the port for local echo; the characters you
type are displayed on screen, then sent through the serial port. Full
Duplex configures the port for host echo; the characters you type are
sent directly out the serial port, then the host computer “echoes”
them back to your computer. Most host computers now allow full-
duplex transmission.

Bits/Char

Each character is stored in memory as one byte. A byte is made up of
eight bits. Depending on the remote device, you may want to change
the number of bits per character when transmitting through the
RS232 port.

Strip Bit

This option determines whether the transmitted characters’ eighth
bit is “stripped” (i.e., set to zero). If your system works correctly
with eight-bit characters, you’ll normally not want the eighth bit
stripped.
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Xon/Xoff and Rts/Cts

These two choices represent flow control protocols. When transmitting
through the RS232 port, your computer and the remote device must be
able to tell one another when to start or stop sending information.
Choose the flow control that the remote device supports.

Install Printer

This option lets you tell the computer which type of printer you have,
as well as which features of the printer you wish the computer to
activate when printing.

The Install Printer option is a systemwide installation that provides
information to any utility or application. Whether or not a given pro-
gram checks the Install Printer information before printing depends on
the particular program itself. For example, the Print Screen option
under the Options Menu on the GEM Desktop uses the Install Printer
information, but other utilities or applications may not. Check the
manuals that came with your programs to see if they make use of the
Install Printer information.

Once you've set the Install Printer parameters, click on the OK
button (or Cancel button to exit and void any option just set).

INSTALL PRINTER
Printer Type: Dot
Color:
Pixels/Line: TN
Quality!
Printer Port:
Paper Type: TR

Printer Type

Your choices are Dot (dot matrix printers) and Daisy (daisy wheel
printers). Click on the appropriate box according to the type of
printer you have.

Color

Your choices are B/W (black and white, that is, monochrome
printers) and Color (color printers). Click on the appropriate box
according to the type of printer you have.

’ F . -



S S S S S S S S

Pixels/Line

This option is for use with dot matrix graphics printers only. Pixel
means picture element. On dot matrix printers, a pixel is a dot.
Dot matrix printers print a certain number of pixels (dots) per line
when printing in graphics mode. If you have an ATAR| Dot Matrix
Graphics Printer, choose 1280. If you have an Epson, or Epson-
compatible dot matrix graphics printer, choose 960. Both values,
1280 and 960, assume an eight-inch printed line.

Quality

For use with dot matrix printers only. Choose Draft for draft-quality
printing. Choose Final for printing that is letter or near-letter qual-
ity (your printer must support near-letter-quality printing, of course).

When printing graphics, your printer will make one pass of the print
head if set to Draft. For darker graphics, use Final (but keep in mind
that the printer will make two passes of the print head, and so take
twice as long to produce the graphic).

Printer Port

If you have a paraliel printer, choose Printer. Parallel printers connect
to the port marked " Printer” on the back panel of your computer. If

you are using a serial printer, choose Modem. You should thus have
your printer connected to the port marked “Modem” (the RS232 port)
on the back of your computer.

Note: When using a serial printer, be certain you've configured the
RS232 port for Xon/Xoff flow control. (See the section on Set RS232
Configuration earlier in this chapter.)

Paper Type

If your printer feeds paper automatically by means of a tractor or
single-sheet feeder, choose Feed. If your printer accepts only a
sheet at a time (which you must insert manually), choose Single.
The Single option prevents the printer from printing beyond the end
of a page should your text run longer than a single sheet.
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File
The File Menu contains options that allow you to manipulate your

files, manage your windows, create folders, and format disks.

Desk IGHRTF, View Options

Shan Inta, ..
Hew Falder... |
Liase

Liose Hindon

Farnat

Open

The Open option is used to run a program or reveal the contents
of a disk, file, or folder. To begin a program or open a file, select
the file, point to the Open option in the File Menu, and click the
left mouse button once.

An alternative to the Open option is to point to the file, then quickly
double-click the left mouse button.

Show Info

When you select a file or desktop icon and then select the Show
Info option, the screen displays information about the file or desk-
top icon you’ve selected. For example, the Show Info box for a
Floppy Disk icon might look like the following:

DISK INFORMATION

Drive Identifier: B:
Disk Label: SAMPLE .DSK
Number of Folders: -0
Number of Items: J—
Bytes Used: __165492
Bytes Available: __189440
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The Show Info box identifies the disk and gives the number of
items stored and the number of bytes both used and available.

The Show Info box for a file might look like the following:

ITEM INFORMATION
Name: SAMPLE .PRG

Size in bytes: ____4540
Last modified: 05/29/85 85:41 pn

Rttributes: Read/Write
Read-0nl
[ ok ] [Cancel |

The Show Info box for a file identifies the item and gives the size, date
last modified, and its read/write attributes. The Read/Write and Read-
Only options allow you to alter a file's read/write attributes. Choose
Read/Write if you want to be able to modify (“write to”) the file; choose
Read-Only if you want the computer to only *“read” but not “write to”
the file. The Read-Only option protects valuable files from accidental
modification.

You can rename the file within the Show Info box. Press [Backspace]
or [Esc] to delete the filename, type a new name, and either press
[Return] or click on the OK button to write the new filename on
the disk.

Note: Depending on the number and size of your files, the number of
bytes used plus the number of bytes available may not equal the
exact storage capacity of the disk. This is because the ST Computer
reserves at least 1024 bytes on the disk for each file, even if the file is
smaller. You should use Show Info’'s Bytes Available information to
monitor your available disk storage space.

New Folder

Folders are organized collections of files. They are neither programs
nor data; you create folders as a means of organizing your files. If
you have a window that contains numerous files, it can become diffi-
cult to distinguish any one item from the others. Because you may
want to organize those files to make them readily accessible, the GEM
Desktop allows you to create folders in which to store related files.
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When you use this option to create a folder, the following Dialog
Box appears on your screen:

NEW FOLDER
Name: SAMPLEL._.___

Refer to Folders in Chapter 3 for a complete description of using
folders.

Close and Close Window

There are three ways to close a window. If you have a window on

your screen and you don't want it displayed, you can either select
the Close or Close Window options from the File Menu, or you can
click on the window’s Close Box.

It's always a good idea to close windows if you are not using them.
Since you can have four windows open on the GEM Desktop at any
one time, any extra open windows only serve to use up available
desktop space.

Both the Close and Close Window options shut down only the
currently active window, not all the windows on the GEM Desktop.
But there is a difference between the two: if a given folder’'s window
is active, the Close option (or Close Box) will close it down and return
you to the folder's Floppy Disk window; however, Close Window will
at once close down both the folder's window and the Floppy Disk’s.

Format

In Chapter 2 you were shown how to format a disk. This section
will not take you step-by-step through the process again. Instead,
it will review a few important points about disks and formatting
them for use.

The surface of a floppy disk is similar to the surface of a record. As
with a record, the information that you store on disk is recorded in
circular patterns. However, unlike record patterns, disk patterns are
not in place when you first buy the disk; you must put them onto the
disk before you can use it. Furthermore, a record is mechanically
recorded, whereas a disk is magnetically recorded (more like audio
tape). The process of preparing a disk to accept data is called
“formatting.” To format a disk, select the Floppy Disk icon to be
formatted, then select the Format option from the File Menu.
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The only chance to label a disk comes in the Format box. (You
cannot rename a disk using Show Info; you must reformat it.) Type
in the name using the ST Computer keyboard. Use the [Backspace]
key to delete any errors. Click on the OK button and the disk will
be formatted (and named). A Format Working box monitors the
formatting process.

When the process is complete, a Dialog Box displays the number of
bytes available for storage on the disk. If your disk doesn’t show
357,376 (single-sided) or 726,016 (double-sided) bytes available, the
disk may be defective. Try formatting again. If the problem persists,
place a new disk in the disk drive and format it.

Warning: You can reformat old disks, but if you do, any data that
was on the disks will be lost—forever. Copy the files you want to
save before reformatting the disk.

View

The View Menu allows you to control whether your files will be
displayed as Icons or Text, as well as whether they will be sorted
(ordered) by Name, Date, Size, or File type.

Desk File TN Options
. Show as Icons
Shou as Text

v Sort by Name

| Sort by Date
Sort by Size
Sort by T

Note: Any changes you make using the View Menu can be saved
to disk. Refer to the Save Desktop section for instructions.
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Show as Icons and Show as Text

The check mark in front of the menu item indicates how you will
view the file display. To modify how files are displayed, select the
option you want by clicking on it. The following two windows show
a file display as Icons and as Text for the same disk.

Shown as lcons

T
155147 bytes used in 6 items.

i Iy

SAMPLE CONTROL .ACC  EMULATOR .ACC

<]

Shown as Text

155147 bytes used in 6 items,
¥ SAMPLE 11-26-85 12:04 an ¢
BASIC PRG 123988 05-29-85 05:34 pn
BASIC RSC 4930 05-29-85 05:34 pn
CONTROL ACC 15238 11-20-85 12:88 am
EMULATOR ACC 6451 11-20-85 12:01 am
SAMPLE  PRG 4540 11-20-85 12:01 am

B
<] B

When a file is displayed as text, the window shows the filename
and size, as well as the date and time the file was last modified.
A small box icon next to a filename in the text-displayed window
indicates that the file is a folder, not an application or data file.

Sort by Name, Date, Size, and Type

When you open a disk or folder's window, the computer orders

the items on screen according to the criterion set with this menu.
When Sort by Name is set, files are listed in alphabetical order.
Sort by Date lists the files chronologically, with the most recently
created or revised file appearing first. When Sort by Size is set,
files are listed according to the number of bytes per file, with the
largest file appearing first. Sort by Type orders files alphabetically
according to their extensions, grouping files with common extensions
together.
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The screen below shows two windows for the same disk, but one
window’s files are ordered by Name and the other’s by Date.

Sorted by Name

155147 bytes used in 6 items.
¥ SAMPLE 11-20-85 12:04 am @
BASIC PRG 123988 B5-29-85 05:34 pn
BASIC RSC 4930 05-29-85 B85:34 pm
CONTROL ACC 15238 11-20-85 12:08 am
EMULATOR ACC 6451 11-20-85 12:81 anm
SAMPLE  PRG 4540 11-20-85 12:01 am [

o] [o]E

Sorted by Date

LA
155147 bytes used in 6 items.

W SAMPLE 11-20-85 12:84 am ¢
SAMPLE  PRG 4540 11-20-85 12:81 am
EMULATOR ACC 6451 11-20-85 12:81 am
CONTROL ACC 15238 11-28-85 12:00 an
BASIC PRG 123988 85-29-85 05:34 pn
BASIC RSC 49308 085-29-85 B5:34 pn

<] [o

]

Options

The Options Menu includes a variety of useful desktop features.

Desk File View RUASTH
Install Bisk Brive..,
Install fpplication..,

P

= /4

FLOPPY DSK
Set Preferences...
Save Desktop

Print Screen

FLOPPY DISK

Note: Any changes you make with the Options Menu can be
saved to disk. (See the Save Desktop section later in this
chapter.)
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Install Disk Drive

When you switch on your ST Computer, the GEM Desktop displays
two Floppy Disk icons. Each disk has a disk identifier (a letter) and
an icon label. You can change the label, remove a disk icon, or
re-install a disk icon with the Install Disk Drive option.

Select a Floppy Disk icon, then select the Install Disk Drive option.
The following Dialog Box will be displayed:

INSTALL DISK DRIVE

Drive Identifier: A
Icon Label: FLOPPY DISK_

[Install] [Renove || Cancel]

To install a new disk icon, select a disk icon, choose Install Disk
Drive, then type in the disk identifier (any letter) of the icon you

wish to install (“c” stands for Cartridge; “C” for Hard Disk). You
may have only two disk icons (A and B) representing your floppy
disk drives.

To change the disk label, point at the current name and click
the left mouse button; press [Backspace] on the ST Computer
keyboard to erase the current name; then type in any name you
wish. Click on the Install button.

To remove a disk icon, select the icon, choose Install Disk Drive,
then click on the Remove button.

To re-install a disk icon you've removed, select the remaining icon,
choose Install Disk Drive, then type in the disk identifier of the
missing disk. Click on the Install button.

Warning: Use the Install Disk Drive option with caution. If you
remove both disk icons and then save this modified desktop to your
Desktop disk, you'll need to make a new Desktop disk to get the disk
icons functioning again.

Install Application

With the Install Application option, you can determine the kind
of data file that will open an application.
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With an applications program selected in a window, select the
Install Application option from the Options Menu. The following
Dialog Box will be displayed:

INSTALL APPLICATION

fipplication Name: WORDPROC.PRG
Document Type: ..
fpplication Type:

0 [0S ] [T0S-takes parameters |

|
[ l|Cancel|1

There are two methods of installing an application. The first method
is to tell the computer that you'd like files with a particular filename
extension (the three letters that follow the period in a filename), once
opened, to automatically run the application program you've installed.
For example, suppose you are using a word processor and have word-
processed files named with the .DOC (*‘dpocument”) extension. You
can install the word processor to run from this extension. Type
DOC after the Document Type option in the Install Application box.
You can now open any file with the .DOC extension and the word
processor will run automatically, simultaneously loading the file
opened. The program file, however, must be in the same directory
as the data file.

Choose “GEM" if you have an application that takes advantage
of the special windowing features of GEM. Choose “TOS" if the appli-
cation is not a GEM-compatible program. Click on the OK button.

The second method of installing an application is to use the “TOS-
takes parameters” option, provided, again, that your program does
not use the features of GEM. In this case, you do not need to specify a
filename extension. You simply install the application with “TOS —
takes parameters,” then click on the OK button. When you open the
installed application, you see the following Dialog Box:

OPEN APPLICATION

Name: SAMPLE .TTP
raraneters:

| 0K ] [Cancel |
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Type in the filename(s) or other parameters the program expects.
Click on the OK button. The applications program loads and uses
the parameters supplied.

Note: The three ways to install an application may be explicit in a
given application’s filename extension. For instance, .PRG files
denote GEM-compatible programs; .TOS denotes non-GEM applica-
tions; and TTP denotes non-GEM, parameter-taking applications. A
TTP file need not be installed. The Open Applications box will appear
automatically when you run any TTP file.

Set Preferences

The Set Preferences option lets you determine how the ST Computer
interacts with you through the prompts and Dialog Boxes, and what
resolution your monitor display will be in.

When you select the Set Preferences option, the following Dialog
Box is displayed:

SET PREFERENCES

Confirm Deletes!
Confirm Copies:
Set Screen Resolution:
[ High |

Confirm Deletes and Confirm Copies

These two options determine whether the ST Computer waits for
confirmation before deleting a file or making a copy. You can set
up the Alert Message system to suit your own needs.

Select Screen Resolution

These parameters provide one of three video screen resolutions:
Low, Medium, or High. With the ATARI High-Resolution Monochrome
Monitor, you can select only High Resolution. With the ATARI RGB
Color Monitor, you can select either Medium or Low Resolution. For
best results with a television, you should select Low Resolution.

Warning: If you change screen resolution without a Desktop Disk in
Drive A, the Desk Accessories will be erased from memory.
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Save Desktop

To save any modification you make to the GEM Desktop, use the
Save Desktop option. This is an extremely valuable feature— you
can save the desktop format you prefer and have it come up every
time you switch on your computer.

Insert your Desktop disk (a disk that contains the CONTROL.ACC and
EMULATOR.ACC files) in your drive and click on the Save Desktop
option. The computer writes a file called DESKTOP.INF to the disk.
Each time you switch on your computer with that disk inserted, the
system checks the DESKTOP.INF file and runs the desktop as you
have modified it. The size and location of windows and any changes
you have made using the Desk, View, or Options Menus are saved to
the DESKTOP.INF file.

Print Screen

This option prints the current screen display; it prints everything
displayed, including the mouse pointer. You must have a graphics
printer connected to your computer to use the Print Screen utility.
Make sure the printer is switched on and that it has been installed
(see the section on Install Printer earlier in this chapter). Then click
on Print Screen to activate the function. Press [Alternate] [Help] to
stop printing midway, if necessary.

You can also activate the Print Screen utility by pressing [Alternate]
[Help]. Press [Alternate] [Help] again to stop printing midway, if
necessary.

Note: If you select the Print Screen utility without first switching on
your printer, the system will time-out in approximately 30 seconds.
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